
1



2

ОТ АВТОРА

Этот учебник адресован прежде всего тем, кто делает только первые шаги в изуче-
нии замечательной программы 3D моделирования SketchUp, но, возможно, будет интере-
сен и достаточно опытным ее пользователям, и они также найдут для себя что-то новое и 
полезное. Книга написана в виде так называемые «пошаговых уроков» – одном из самых 
популярных жанров учебных материалов по компьютерным программам. Это и понятно – 
ведь они, как правило, живей, интересней и «доходчивей», чем сухое справочное изложе-
ние информации по устройству программы. К тому же одновременно происходит не только 
знакомство с инструментами и опциями программы, но и осваиваются рациональные прак-
тические приемы работы в ней. 

Ключевая идея изложения предлагаемого учебником материала заключается в том, что-
бы не просто выложить отдельные уроки по некоторым типичным задачам моделирования в 
SketchUp, а объединить их «сверхзадачей» моделирования составляющих комплексного объ-
екта. и выбран собственно сам объект – личная среда обитания, дом (квартира). Почему дом? 
Во-первых, эта тема однозначно наиболее близка каждому. Во-вторых, это множество разно-
образных и разнородных объектов: от стен до мебели, даже до чашки кофе на столе рядом с 
вашим компьютером – есть над чем поработать! И, наконец, это не только возможность полю-
боваться на воплощение своих фантазий в виртуальной модели, но и решение абсолютно жиз-
ненных и прагматичных проектных задач, дизайна интерьера или просто ремонта своей квар-
тиры, подбора и расчета потребности в отделочных материалах, расстановки мебели и т.д. От-
сюда определилось и название книги «Школа 3D ремонта», и основная цель – показать, КАК 
это можно делать в SketchUp...

В наших уроках, как и в реальном строительстве и обустройстве дома, начнем со строи-
тельных конструкций, затем перейдем к отделке, начнем наполнять наш виртуальный дом пред-
метами, последовательно переходя от объекта к объекту, и конечно, параллельно изучая ин-
струментарий SketchUp применительно к текущей задаче.

Здесь в качестве «учебного полигона» использована реальная планировка маленькой 
однокомнатной квартиры. Конечно, архитектурно-планировочные, дизайнерские и др. реше-
ния показанного проекта совершенно условны, поскольку диктовались чисто учебными зада-
чами по теме книги, а поэтому даже не имеет смысла их обсуждать. Кстати, читатель при же-
лании может сразу, с первых уроков, начать моделирование не с предлагаемой учебной ситу-
ации, а со своего дома (квартиры). Таким образом в итоге можно получить реально нужный и 
полезный результат – 3D модель своего дома, которая не раз еще пригодится при обустрой-
стве жизненного пространства. 

Несколько слов о структуре книги. Обучение на основе пошаговых уроков предпола-
гает, что пользователь хотя бы в общих чертах знаком с программой. Тем не менее, по ходу 
собственно моделирования в рамках учебного проекта, подробно рассматриваются и базовые 
принципы устройства SketchUp Pro: самые востребованные элементы интерфейса, инструмен-
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ты, опции и т.п. – они представлены, как подзаголовки к названиям-темам отдельных уроков: 

Урок 1. ГОТОВИМ СТРОЙПЛОЩАДКУ /... стр. 5
• Настройки программы 
Урок 2. чертим план /... стр. 10
• Основы моделирования • Inference engine • Линия • Прямоугольник • Рулетка • 

Ластик • Размеры
Урок 3. разделяй и... строй! /... стр. 15
• Группы • Скрыть/Отобразить • Слои
Урок 4. даешь третье измерение! /... стр. 19
• Тянуть/Толкать • Виды • Камеры
Урок 5. ставим ОКНА... /... стр. 25
• Контуры • Выбор • Круг • Дуга • Следуй за мной • Вращение • Перемещение • 

Компоненты • Оси 
Урок 6. ...И ДВЕРИ /... стр. 39
• Материалы • Режимы рендеринга • Масштабирование
Урок 7. монтируем водо-тепло-сантех. оборудование /... стр.47
• Управление текстурами • Блокирование привязок • Моделирование surface • Сгла-

живание поверхностей • Пересечения объемов • Импорт 3ds
Урок 8. отделОЧНЫЕ РАБОТЫ /... стр. 58
• Цвета, текстуры • Сцены • Тени • Разрезы
Урок 9. ставим МЕБЕЛЬ /... стр. 66
• Текст • Инструменты «Песочницы»
Урок 10. входим внутрь /... стр. 75
• Инструменты прогулки • Стили отображения
Урок 11. печатаем, экспортируем, анимируем... /... стр. 87
• Распечатка • Экспорт 2D графики • Экспорт 3D модели • Анимация

Фактически перед вами «переиздание» (версия 2) учебника, который базируется теперь 
на версии SketchUp 8 Pro. Почему потребовалось переиздание, думаю, понятно – за эти не-
сколько лет со времени написания учебника произошел ряд принципиальных событий в мире 
SketchUp, начиная с появления новых версий и заканчивая сменой владельца программы. Итак 
– почему все-таки  не последняя версия – от сегодняшнего владельца Trimble SketchUp 2013? 
Не отвлекаясь здесь на подробности, можно констатировать, что к сожалению, в ней не ока-
залось ни одного настолько реально значимого, обоснованного, полезного «плюса» – улучше-
ния или нововведения, чтобы они хотя бы перевесили те «минусы», которые возникли в этой 
новой версии! Таким образом для практически работающего в программе пока очень сомни-
телен смысл перехода на 2013-й с предыдущего – отработанного, надежного, фактически по-
следнего «гугловского» SketchUp 8-й версии, на основе которого и будем изучать программу. 

Что же касается опасений пользователя (особенно начинающего) оказались на «пере-
путье» версий – на самом деле никаких «революций» в программе не произошло, практиче-
ски все инструменты и опции остались все те же… А раз так, «косметические ремонты» новых 
версий (а большего вряд ли стоит ожидать и в будущем!) никак не мешают использовать для 
полноценного изучения программы учебные пособия по SketchUp 8.0 (да и более ранним)... 

Поскольку в учебнике рассматриваются темы, необходимые прежде всего в контексте 
текущего учебного примера, некоторые инструменты и опции SketchUp остались «за рамками» 
книги. А самую полную информацию по всем опциям, инструментам и др. возможностям про-
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граммы читатель сможет найти на сайте автора http://prosketchup.narod.ru в учебнике-справоч-
нике «SketchUp – просто 3D!». 

По отдельным, особо значимым моментам или в качестве дополнительной информации в 
книгу включены уточнения, рекомендации, примечания и комментарии – они в тексте выделе-
ны так, как этот абзац. 

Конечно, приведенные в книге комментарии, замечания и оценки по тематике учебни-
ка выражают только личное мнение автора, исходя из личного понимания и опыта, и конечно, 
не претендуют на роль единственно однозначных и правильных. В том числе непосредственно 
по методике и способам решения задач моделирования – хотя бы по причине того, что один 
и тот же результат может быть достигнут самыми разными шагами и способами, а «универсал» 
SketchUp в этом плане предоставляет все возможности…

Буду благодарен за отзывы и пожелания по книге, готов ответить на возникающие до-
полнительные вопросы (пишите: prosketchup@narod.ru) и, конечно, – желаю творческих успехов! 

Александр Петелин 2010 – 2013 гг.
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Урок 4. 
даешь третье измерение!
• Тянуть / Толкать • Виды • Камеры • 

В этом уроке наша задача – закончить моделирование «строительной коробки» квартиры: 
стен, дверных и оконных проемов.

Во-первых, отключаем пока не нужный нам слой «полы» и назначаем текущим слой «стены». 
Перед нами группа «steni» с планом оснований стен в уровне пола, созданная в прошлом уроке. 
Возможные два варианта работы с группой – либо работать внутри нее (без разрыва опцией Expl-
ode), либо все-таки разгруппировать. В принципе, и тот, и другой вариант в этом случае равноцен-
ны, так что это вопрос личных предпочтений и удобства. 

Если мы решили работать внутри группы, входим в режим ее редактирование через меню 
Edit > Group > Edit Group или, что аналогично, делаем контекстный клик на группе и выбираем оп-
цию Edit Group. А можно использовать еще более быстрый способ входа в режим редактирования 
для быстрого выбора внутри группы или компонента: одиночным кликом выбирается вся группа, 
а двойным, тройным и т.д. количеством кликов (в зависимости от количества уровней «вложенно-
сти» объектов группы) «добираемся» до нужного элемента. 

Итак, выбираем инструмент  Push/Pull (Толкать/Тянуть), помещаем его на любое место 
поверхности плана стен – автоматически происходит ее выбор. А теперь настает очередь долгож-
данного чуда трехмерной графики – возникновение из плоской фигуры «живого» объема: просто 
поднимаем план движением курсора вверх (по синей оси) на приблизительную высоту (только по-
казывая направление), далее набираем на клавиатуре замеренную ранее высоту уровня потолков 
над полом (в примере – 2550 мм), смотрим правильность набора числа в панели Measurements (Из-
меритель), нажимаем Enter – стены готовы! 

Удивительно, но далее мы увидим, что создание в SketchUp всего многообразия трехмерных 
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Урок 4. даешь третье измерение!

объектов в большинстве функций основано на использовании этого же принципа – «выталкивания» 
или «вытягивания» плоской двухмерной фигуры в третье измерение, что, кстати, отражено и в на-
звании самой программы: Sketch – эскиз, Up – вверх! 

А сейчас, поскольку у нас появилось третье измерение, имеет смысл отвлечься на подроб-
ное рассмотрение инструментов и приемов навигации по трехмерным сценам SketchUp. Это очень 
важно – без свободного владения камерой, через которую мы видим и контролируем все происхо-
дящее в рабочем пространстве программы, эффективная работа просто невозможна! 

 Инструменты навигации в любом 3D приложении – однозначно самые востребованные и часто 
используемые: в процессе работы мы постоянно будем перемещать камеру относительно модели, 
рассматривая ее с разных ракурсов. А значит, удачное решение этих функций во многом определя-
ют комфортность, скорость и эффективность работы в целом. И наоборот, можно привести приме-
ры замечательных по возможностям 3D редакторов, желание изучать которые отпадает сразу после 
первого знакомства, и только по одной причине – крайне неудобной реализации опций навигации. 
Что же касается SketchUp, можно сказать только, что поработав какое-то время в нем, начинаете 
замечать, что автоматически пытаетесь использовать его приемы навигации и в других программах 
(в том числе и не 3D)! Одним словом, такой интуитивно понятный, логичный и удобный инструмен-
тарий управления камерой, как в SketchUp, пожалуй, придется еще поискать в других редакторах... 

 VIEWS (Стандартные виды)
Инструменты камеры представлены, прежде всего, блоками панелей инструментов Стандарт-

ных видов над рабочим окном. Это предварительно установленные, фиксированные виды (проек-
ции), на которые можно переключиться одним кликом в любой момент работы:

• Isometric (Изометрия),
• Top (Сверху),
• Front (Спереди),
• Right (Справа), Back (Сзади),
• Left (Слева)
Есть еще один вид – Bottom (Снизу) не представлен кнопкой на панели инструментов и до-

ступен только из текстового меню Camera > Standard Views.
Со Стандартными видами связан еще один дополнительный механизм обзора (только из 

меню Camera) – выбор режима взгляда между Paraline Projections (Параллельным), в котором все 
линии вдоль каждой из осей параллельны (т.е. в ортогональных проекциях) или Perspective (Пер-
спективным), с перспективными искажениями. Смысл этого механизма заключается в том, что для 
точного выравнивания, измерений и распечаток в масштабе (например – планов или разрезов по-
мещений), логично использовать параллельные проекции, а для более естественного, реалистич-
ного представления сцены в 3D пространстве, конечно, больше подходит перспективный вариант. 
А главное – в параллельных проекциях, понятно, «степень свободы» опций модификаций (переме-
щения, вращения, масштабирования) ограничивается только плоскостью камеры, т.е. на порядок 
повышается точность работы с ними.

Здесь же, в меню Camera видим еще один специфический, также условный вариант проек-
ции – Two-Point Perspective (Двухточечная перспектива), который отличается тем, что все верти-
кали построений параллельны синей оси и между собой, а перспектива работает только для гори-
зонтальных направлений. На практике Двухточечная перспектива традиционно применяется реже, 
но, например, может оказаться наиболее удобной и наглядной для показа интерьера помещения.
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И еще – отключение, «снятие галочки» у строк меню Parallel Projections и Two-Point Perspective 
равноценно включению, переходу в режим Perspective.

Итак, резюмируем – камера может работать как в «ручном» (рассмотрим чуть ниже), свобод-
но управляемом движениями мышки режиме, так и может устанавливать взгляд в сцену через Стан-
дартные виды. Причем любая из этих камер может работать в сочетании с любым из типов про-
екций – например, Iso + Perspective фактически имитирует «человеческий» взгляд в сцену, а Top + 
Parallel Projections – типично «чертежный» вид «Сверху». Благодаря таким широким возможностям 
управления камерой, SketchUp одинаково успешно решает задачи как реалистичного представле-
ния (презентации) сцены в 3D-пространстве, так и точных конструкторских построений, измере-
ний, простановки размеров и распечаток в масштабе (например, планов или разрезов помещений). 

 Camera (Камера)
Второй блок кнопок в основной панели инструментов – это инструменты «ручной» камеры, 

с которой мы как бы произвольно перемещаемся по сцене. 

 Orbit (Вращение) – нажатием и удержанием клавиши мышки вращаем камеру (точнее, 
«объезжаем») вокруг наблюдаемого объекта на фиксированном расстоянии. С одновременно на-
жатой клавишей Shift переходит в инструмент Pan (см. ниже). По умолчанию камера удерживается 
в вертикальном положении, но с нажатой клавишей Ctrl может наклоняться относительно горизон-
та произвольно под любым углом.

 Pan (Панорамирование) – нажатием и удержанием клавиши мышки перемещаем каме-
ру параллельно объекту (и плоскости экрана) на фиксированном расстоянии. 

 Zoom (Лупа) – нажатием и удержанием клавиши мышки увеличиваем (при движении 
курсора вверх) или уменьшаем (движение курсора вниз) изображение объекта за счет приближе-
ния или удаления камеры от него. Фактически – имитация операторских приемов «наезда» и «отъ-
езда» камеры (или зуммирования объектива). Центр изменения масштаба просмотра определяет 
позиция курсора, поэтому для увеличения изображения какого либо объекта имеет смысл сначала 
поместить курсор на него. Можно также, сделав двойной клик инструментом в нужной точке рабо-
чего пространства, отцентрировать направление взгляда по этой точке (направить на нее камеру). 

  Существует особенность поведения инструмента (особенно при большом увеличении) – надо 
помещать курсор на какое-либо построение (от которого он как бы ведет отсчет), а не на пустое поле рабо-
чего пространства, так при этом инструмент может практически перестать действовать.

Еще одна функция инструмента Zoom управляет параметрами объектива виртуальной ка-
меры – Field of View (Поле взгляда). Она доступна из меню Camera или через Zoom при нажатой 
клавише Shift, и позволяет расширять или сужать ширину поля взгляда при фиксированном поло-
жении камеры. При этом Поле взгляда меняется при движении курсора вверх или вниз, что факти-
чески имитирует изменение фокусного расстояния реального объектива, а его величина динамиче-
ски показывается в панели Measurements (Измеритель). Аналогичный результат можно также полу-
чить, просто вводя с клавиатуры нужное числовое значение при активированном инструменте Zoom. 

  На практике намного удобней управлять этими тремя, самыми частыми по употреблению ин-
струментами временным переключением на них из любого другого инструмента (что очень важно – без вы-
хода из него!) за счет использования средней кнопки (колесика) трехкнопочной мышки:

• Нажать и перемещать – аналогично Orbit (Вращению);

Урок 4. даешь третье измерение!
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• Shift + нажать, и удерживая, перемещать – аналогично Pan (Панорамированию);
• Вращать колесико – аналогично Zoom (Лупе): от себя – увеличение, на себя – уменьшение. 

 Zoom Window (Окно увеличения) – нажатием и удержанием клавиши мышки уста-
навливаем границу окна просмотра «растягивающимся» прямоугольником выбора. 

 Zoom Extents (Показать все) – показ всех объектов сцены одновременно. 

 Previous (Предыдущий вид), Next (Следующий вид) – отмены последней ко-
манды точки взгляда (возврата к предыдущей / последующей). Эта опция особенно удобна для воз-
врата из неудачного перемещения камеры, например – в ситуации «въезда» камеры внутрь закры-
того объема стены. 

  Перемещения камеры относительно объектов сцены и изменения параметров ее объектива ча-
сто визуально ошибочно воспринимаются как перемещения самих объектов, поэтому важно помнить, что 
при работе с инструментами камеры объекты на самом деле остаются на своих местах, поскольку действи-
тельно перемещаться в пространстве сцены они могут только инструментами Move и Rotate.

Возвращаемся к моделированию – уточняем детали, например, лоджии: ее фасадное ограж-
дение должно быть высотой 1200 мм, а оно у нас поднялось на всю высоту стен. Помещаем каме-
ру в удобное для обзора положение, отмеряем Measure (Рулеткой) 1200 мм от линии уровня пола 
и по появившейся конструкционной линии инструментом Line рисуем горизонтальную линию вер-
ха ограждения. И не забываем проконтролировать точность построения текстовыми подсказками 
на конечных точках этой линии – Intersection (Пересечение). 

  

Теперь поверхность разделена на две, и верхнюю часть мы просто «продавливаем» инстру-
ментом Push/Pull до противоположной, внутренней поверхности, фактически – насквозь, до ее ис-
чезновения. 

И не забываем сразу стереть лишние вертикальные линии «бывшего» примыкания к боко-
вым стенам.

Урок 4. даешь третье измерение!
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Урок 4. даешь третье измерение!

 

Теперь достроим дверные проемы: сейчас они идут до уровня потолка, а по замерам – на вы-
соту 2100 мм, т.е. имеем 2550 - 2100 = 450 мм стены, которые нужно построить над проемами. Вос-
пользуемся для этого самым быстрым вариантом – активируем инструмент Rectangle (Прямоуголь-
ник) и, «зацепившись» его стартовым углом за крайнюю верхнюю точку проема, растягиваем в на-
правлении диагонально противоположной точки на приблизительную величину. А теперь восполь-
зуемся замечательными возможностями механизма Measurements (Измеритель).

Для каждого инструмента и опции Measurements (Измеритель) автоматически переключа-
ется в его формат показа и ввода числовых значений. В нашем случае, для инструмента Прямоу-
гольник, видим: «Dimensionsh: ...mm;...mm», где первое значение – его ширина, второе – высота. 
И что еще очень удобно – Measurements (Измеритель) «понимает» направление изменения пара-
метров, заданное начальным, «приблизительным» рисованием фигуры.

Итак, зная размеры прямоугольника, которые надо построить, вводим: «678mm;450mm» 
– готово! Или воспользуемся другим приемом – возможностью раздельного ввода величин в 
Measurements (Измеритель): для прямоугольника мы можем (не меняя ширины, которая определи-
лась «по факту» построения) задать только высоту набором в виде «;450». Естественно, аналогично, 
при необходимости можно было бы поменять отдельно только ширину вводом величины в виде «...;».

 Важный момент – правильный формат ввода данных, и здесь прежде всего помним, что рабо-
тают настройки, установленные в диалоговом окне Window > Model Info > Units. Кроме того, если 
правильно не срабатывает механизм Measurements (Измеритель) при вводе чисел в форматах, по-
казанных в этой книге (это стандартные форматы «русского» MS Windows), надо проверить установ-
ки Windows в Панели управления > Язык и региональные стандарты > Региональные параметры > 
Настройка > Числа. Здесь в окошке «Разделитель целой и дробной части» должна стоять запятая  
( , ), а в окошке «Разделитель элементов списка» – точка с запятой ( ; ).

Переходим к оконным проемам – пользуемся, в принципе, аналогичными приемами – снача-
ла разметка (смотрим замеры), затем «продавливание».

Вполне вероятно, что в процессе рисования новых линий-ребер будет происходить автома-
тическое создание новых поверхностей не той ориентации, которая требуется – например, вместо 
появления вертикальной плоскости стены будет происходить «заливка» горизонтальной поверхно-
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сти потолка по ребру их пересечения. Дело в том, что хотя SketchUp стремится правильно нас «по-
нять», но иногда ситуация бывает просто неоднозначной, а потому остается по ходу удалять ненуж-
ные элементы и достраивать нужные. 

Ну, вот, собственно и все – «коробка» готова! Остается убрать «строительный мусор» и про-
верить качество работы: 

1. Удаляем ненужные больше линии построений и конструкционные линии (удобно пользо-
ваться для этого опцией Edit > Delete Guides);

2. Выбираем все, и проверяем через Entity Info, чтобы все элементы находились в нужном 
нам слое «стены» (если в разных – окошко будет пустое). 

3. Проверяем ситуацию с «лицом/изнанкой» поверхностей – включаем (если работаем не в 
нем) режим рендеринга Monochrome и исправляем возможные ошибки этого плана. 

4. Группируем все элементы и проверяем (или назначаем) имя группы – «steni».


